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Chapter 1

ButtonMenu

1.1 ButtonMenu V1.23 Documentation

ButtonMenu V1.23 Contents
~Introduction~~~~~~~~nn~
about ButtonMenu

~Disclaimer~~~~~~~~~~~~
legal jargon

~Copyright~~~~~~rnnnnnn
copyright information

~Distribution~~~~~~~~n~
distribution guidelines

~Acknowledgements~~~~~~
thankyous

~Compatibility~~~~~~~~~
will ButtonMenu run on your system?

~Requirements~~~~~~n~~n~~
what you need to get ButtonMenu working

~Getting~Started~~~~~~~
how to start ButtonMenu

~Referencen~~ s~
general reference and descriptions

~Contacting~the~author~
how to get in touch with me

~History~~~r~rrrrnmnvnnn
program history
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1.2 Introduction

ButtonMenu allows Kickstart 2.0 (or higher) owners to create menus in
the form of a window full of GadTools buttons. Two programs are
provided: one to allow you to create the menu and one which runs the
menu. It is then possible to run your menu from a startup-sequence,
for example. The GUI for the creator was designed to use Topaz 8,
but it will adapt to the current screen font if it is not too big.

An added bonus is the ability to load ButtonMenu from within ButtonMenu
from within ButtonMenu and so on... This means you can nest menus to
create complicated menu systems.

1.3 Disclaimer

I cannot be held liable if this program causes you to lose valuable
data, nor can I be blamed if this program causes any other problems
with your system. Any problems are entirely the user’s responsibility.

1.4 Copyright Information

ButtonMenu V1.23 - written with DICE C (2.07.56R) on a A600 + 170 Mb HD
(c) Oliver Roberts 1994-1995

ButtonMenu is public domain and the copyright remains with the author.

1.5 Compatibility

ButtonMenu has been tested on an A600 with KS2.05 and KS3.0 using
NTSC/PAL, chip/fake fast, chip configurations.

ButtonMenu is fully OS-Legal, it should work on ANY Amiga with
Kickstart 2.0 or higher.

1.6 Distribution Conditions

ButtonMenu is freely distributable providing none of the distributed
files are changed in any way, ButtonMenu is not sold for profit and
it is not included on any disks that are sold solely for profit. If
ButtonMenu is to be sold for profit, permission must be obtained from
me, the author (Oliver Roberts). This includes magazine coverdisks -
let me know if you wish to use ButtonMenu menus on the disks or
include the ButtonMenu Creator (Amiga Computing take note, especially).

For following files MUST be distributed together if the Creator is to
be included:
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ButtonMenu (ButtonMenu Creator)

ButtonMenu.info

ButtonMenu.guide (Document in AmigaGuide® format
ButtonMenu.guide.info

BMX (ButtonMenu Executor)

BMX.info

Install_ButtonMenu (Commodore Installer script)
Install_ButtonMenu.info

reqtools.library (KS2.0 V38 — Needed for Creator only)

If you just want to distribute your created menu then you can
distribute the BMX program without the files above, if desired.

1.7 Acknowledgements and Thankyous

Regtools.library (c) 1991-1994 Nico Francois

AmigaGuide® (c) Copyright 1992 Commodore-Amiga, Inc.
All Rights Reserved.

Installer project icon (c) Copyright 1991-1993 Commodore-Amiga, Inc.
All Rights Reserved.

The GUI for the Creator was mainly created with:
GadToolsBox V2.0b (c) 1991-1993 Jaba Development

Thanks to Rick Hughes for giving some ideas for new features, and for
the donation he made.

Thanks also go to Andreas Boerner for the mouse-relative ButtonMenus
idea.

1.8 System Requirements

Any Amiga with Kickstart 2.0 (V36) or higher. NTSC / PAL

To run the Creator you will need these disk based libraries in the
LIBS: drawer on you boot disk or HD.

diskfont.library (V36 or higher)
regtools.library (V38 or higher)

To run the Executor you do NOT need "regtools.library" in the LIBS:
drawer, but if you are not using a ROM font (ie Topaz 8 or Topaz 9)
for the menu you will probably need "diskfont.library" (if the font
has not already been loaded into RAM by another program).

1.9 Getting Started
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First make sure you have the libraries mentioned in the
Requirements
section installed in your LIBS: drawer on you HD or boot
From Workbench
Double-click on the ButtonMenu icon.

From the Shell

Type ‘ButtonMenu’ at the prompt. There are no command line options
at present.

1.10 Reference Contents

~How~To~Create~a~Button~Menu~
~How~To~Use~a~Button~Menu~~~~
~Keyboard~Shortcuts~~~~~~~~~~
~Height~Confusion~~~~~~~~n~~~~
~How~to~make~items~fit~~~~~~~
~Limitations~~~~~~mn~~snn

~ButtonMenu~Creator~Menus~—
~Project~~

~Settings~
~ ButtonMenu~Creator~Gadgets~-—
~Item~ (A) v~~~

~Window~Preferences~

1.11 How To Create a Button Menu

Making a menu is simple with ButtonMenu. Just enter the
you wish
to be displayed to the user and the AmigaDOS command lines. Keyboard
shortcuts can be assigned to each item as well (read the Keyboard

Shortcuts~section
for full details).

Entering the commands is made simplier by providing a file requester:

disk.

items

<_7
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just click on the gadget next to the
command
text gadget and select the
file you want to be run when the user clicks on the button.

You can also ask for the command to be
run
in the background (uses the
AmigaDOS ‘run’ command) .

Then select the

font

you wish to use for the buttons, the size of the
window and the

title

for the window. Then select '
Save
' from the menu.

1.12 How to Use a Button Menu

Type '‘BMX <filename>’ at a DOS prompt and the menu will appear. Where
<filename> is the name of a ButtonMenu datafile which you have
previously saved (defaults to ‘BM.dat’). The menu should now appear.

Alternatively, you may double click on a ButtonMenu datafile icon
and the menu will be displayed.

Now just click on the button (or use a keyboard shortcut) to run the
corresponding commands, and click the close gadget when you have
finished. Pressing the ‘Shift’ key (or right mouse button), while
pressing the button, will activate the second function if there is one.

1.13 Amiga Keyboard Shortcut Theory

You can specify keyboard shortcuts for each item, if you want. <«
You
are not allowed to use the same key for more than one item (ButtonMenu
will tell you if you do). Pressing any of the keys a..z in your

generated menu will have exactly the same effect as keys A..Z, thus
case 1is not important (unless you have the

doc~function

enabled!)

There are a few ways of denoting the keyboard shortcut in the item
text. For example, with shortcut ‘B’ you could have:

[B]l]uttonMenu or (B) uttonMenu or {B}uttonMenu etc...
But the preferred way is to use an underscore character underneath

the letter to be emphasized - like most new Amiga applications. You
do this in ButtonMenu by putting an ‘_’ character directly before the
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character to be underscored. For example:

"_ButtonMenu" produces ButtonMenu

Therefore, only use the underscore character for this purpose - using
more than one won’t make any difference as the leftmost ones will be
ignored and not displayed.

1.14 Height Confusion

Some people may find the way the Height of the menu window is <+

calculated
confusing - or uninteresting! So for users who want to know why the
height is what it is, here is a little (well... long) explanation:

The Amiga 0OS will always use the screen’s default font (set in Workbench
preferences) for the text in the title bars for each window opened.

This means that the size of the title bar is variable when running the
menu with ‘BMX’ and it is inconvenient to keep the height of the window
constant - the calculations in the ButtonMenu Creator would also have
to be used in the 'BMX’ program which would make the program nearly as
large as the creator, and would create incompatibilities with different
systems. I wanted the menu to be displayed as quickly as possible with
the smallest possible program.

So, you are asked to enter the

maximum~inner~height

for the window,

which is the height of window excluding the title bar and bottom border.
The *

Calculated~Total~Height

" gadget will display an estimate for the
total height of the window, using the current screen font.

Included is a

Height~Adjust

! feature. This will alter the height
further, by removing any blank lines that will not be used giving a
slightly tidier menu. To do this though, the ‘Calculated Total Height’
is calculated as before, but with the smallest possible height.

1.15 Window too small

If you have the Adjust Height feature enabled, or are trying to save
your menu, and get any error message saying that the item(s) won’t
fit in the window, then here are the possible causes/solutions:

Causes

* The text length of one of the items is too long




ButtonMenu 7 /11

(and/or longer than the width of the window)
* The font is too large
* The window is too small
+ Too many items

Solutions (a bit obvious!)

Shorten the length of the item texts
Select a smaller font

Enlarge the window

Delete some of the longer items

* o ok X

1.16 Limitations

The only limitation to the menus you create is that there must be at
least 1 item and no more than 100 items. If you need more items then
let me know.

1.17 The Project Menu

New : Resets the creator by deleting all items. Warning: Make
sure you have saved any wanted edits before selecting!

Open : Load a ButtonMenu datafile which you have previously saved.

Save : Save current edits back to the same file which you have
just loaded. If this a new file, a file requester will be
available for you to enter a new name.

Save As: Save current edits backs to another file.

Test : Display the menu which you have designed. This uses the
external BMX program to load the menu - BMX must therefore
be in the search path somewhere.

About : Some copyright notes and version information.

Quit : Quit ButtonMenu unconditionally.

1.18 The Help Menu

This menu provides some brief hints on how to use ButtonMenu, without
having to look at the document you are reading now.

This menu maybe deleted in the future and be replaced by AmigaGuide
on-line help, with the aid of this document.
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1.19 The Settings Menu

Save Icons?

If you select this item, icons will be saved with your
datafiles so that the menus can be started from
Workbench with a click of a button.

Save Settings: Save the current state of the Save Icons switch in the

"s:ButtonMenu.config" file.

1.20 Main Iltem Gadgets

New Item

Delete Item:

Up
Down

Item Text

DOS
Command

Keyboard
Shortcut

Run command:

in
background

Add a new item to the menu, after the currently selected
one (or the start if there are no items).

Erase the currently selected menu item.
Move the currently selected item up the list.
Move the currently selected item down the list.

The text to be displayed on one of the menu buttons. If
you put a ‘_’ character in front of another character,
ButtonMenu will denote that letter as the keyboard
shortcut (you must also but this letter in the keyboard
shortcut requester).

The command to be executed when the corresponding menu
button is clicked. This is to be in the same format as
you would run it from the CLI manually. You can also
select commands via a file requester, so you don’t need
to remember the exact filenames.

Specifies an optional key that performs the same function
as clicking on the button on the finished menu.

Tells the Amiga to run that command as a background task.
This does the same thing as ‘run >NIL: <command>’ would
do, where <command> is the contents of the DOS Command
gadget. This command is activated by the left mouse
button or the keyboard shortcut on the final menu.

1.21 Secondary Item Gadgets

Enable Doc
Function

Doc
Filename

Tell ButtonMenu that you want this item to have a second
function which will be activated by holding the right
mouse button or shift key and then pressing the left mouse
button or keyboard shortcut.

In conjuntion with the Doc Reader gadget you may enter the
filename of the corresponding document. The filename will
be loaded by the Doc Reader. However, you may specify no
doc reader and enter an AmigaDOS commandline in this
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Font Used
For Items

Title

Width

Max Inner
Height

Adjust
Height

Calculated:

Total
Height

Position

Single
Choice

Doc
Reader

If you have any suggestions,
let me know.

gadget - this provides maximum flexibility.

1.22 Window Preferences Gadgets

The font to be used for the item text on the menu buttons.
Click the Choose Font button to change the font.

Text to be displayed in the title bar of your menu - uses
a separate font.
Width of the menu window (in pixels).

The height of your window excluding the title bar and
bottom border.

With this feature turned on, any blank lines at the bottom
of your menu window will be removed by decreasing the
height. Checks will also be made to see if your items
will actually fit in the menu window with the dimension
you have specified whenever you alter these, the font or
the Item Text. With the feature off, these checks are
only made when saving.

This is the estimated total height of your window including
the borders. Assumes the screen font you will use for the
menu will be the same as the current one - that is why it
is an estimate.

Makes the menu appear either at the Top Left of your
screen (below title bar), the Centre of your screen or
relative to the position of the Mouse pointer.

Allows only ONE choice to be made on the menu. After the
corresponding command has returned, the menu will close.

This is an optional field which may be filled with the
intended command line of your preferred document reader
(e.g "run c:ppmore"). This field will be used by the
secondary functions of all items, if it is not empty.

1.23 Drop me a line sometime

bug reports or then don’t hesitate to
Providing me with a SAE will ensure you get a reply.

My permanent home address is:

30 Tillett Road

Norwich
Norfolk
NR3 4BRJ
ENGLAND
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You can contact me via e-mail at this address:
0.J.C.Roberts@essex.ac.uk

You might also want to look at my WWW pages on the Internet, which

include a ButtonMenu page and an F1GP-Ed page (my main Amiga project).

From here you can download the latest versions before anywhere else

gets hold of them - the URL for my homepage is:

http://sol45.essex.ac.uk/Web/robeoy/index.html

1.24 Program History

V1.23 - 13 January 1995

Bug Fixes: The "Position" keyboard shortcut in the Creator now works
correctly - a couple of other shortcuts also fixed.

Possible bug in the Executor fixed.

V1.22 - 10 January 1995

Replaced "Centre Window" switch with a choice of Top Left, Centre or
Mouse relative.

The "Test" item on the Project menu has been improved - there is now no
need to save before you test, as a temporary file will automatically be
written to RAM:, and is deleted after use.

The BMX executable can now be made resident.

More minor source code optimization.

V1.21 - 17 November 1994

Optimized the source code further.

Added better memory (lack of) checking.

Documenation is now in AmigaGuide format, only.

Added an AmigaDOS "Version" string.

Provided an "Installer" script.

Bug Fix: Some of the keyboard shortcuts in the Creator didn’t work.

Some other minors bugs fixed.

V1.20 - 31 August 1994

ButtonMenu nows uses functions available in KS 2.0 (or higher) instead of the

equivalent ANSI C functions. The has resulted in a drastic decrease in
executable size for the BMX executor (about a 50% reduction).
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Added a "Test" option to the project menu in the creator which uses BMX to run
the menu.

Added Workbench support to BMX which allows ButtonMenus to be loaded via an
icon. It then made sense to add a settings menu with a Save Icons option and
a configuration file saved in s:

Changed the Adjust Height error handling slightly resulting in less annoying
requesters (also corrected a spelling mistake in the error message).

Added a zoom gadget to the menu windows that are created.
Added an option to centre the ButtonMenu when it is opened.

New option to allow ButtonMenus to act more like requesters (ie only one
choice is allowed - then the window is closed automatically).

Amigaguide documentation provided in addition to the standard text doc.

Bug Fix: Removed a bug which caused gadgets in the window to be
refreshed more than once - resulting in flickering.

V1.10 - 15 August 1994 (BETA version — not publically released)

Added a keyboard shortcut facility - datafiles changed accordingly, but old
ones are still supported.

Added an option to display docs as a secondary action.

New—-look menus when ButtonMenu is run on KS 3.0 or higher.

Bug fixes: I discovered a bug concerning the 4 buttons underneath the
item listview gadget. Now, the buttons are checked in addition
to being disabled when appropriate.

A possible bug in the Executor message handler - fixed.

Not all the text strings were freed properly which sometimes
gave memory failures (ie Memory Insane) - fixed this.

V1.00 - 28 July 1994

First release.
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